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• Interactive Media Corporation License Agreement for ActionLine

NOTE: To use this version of ActionLine, you must read and agree to the following license
agreement:

The  manuals  and the accompanying software programs are copyrighted and all rights are
reserved by Interactive Media Corporation. Interactive Media Corporation reserves the right
to make periodic modification of this product without obligation to notify any person or entity
of such revision. Copying, duplicating, selling, or otherwise distributing any part of this
product without the prior, written consent of an authorized representative of Interactive Media
Corporation, is prohibited.

ActionLine is a trademark of Interactive Media Corporation. Apple, Macintosh® and
QuickTime ™ are registered trademarks of Apple Computer Inc.

• IMC grants you a non-exclusive, non-sub-licensable, license to use one copy of the enclosed
software on a single computer. You may not duplicate the software, except to make one backup
copy or to install onto the hard disk of your computer.

• You may not place copies of the ActionLine Editor or the ActionLine Viewer on any web
server, or distribute ActionLine electronically.  You may place the Java Viewer on your web
server, in conjunction with Java applets you create using ActionLine.

For the purposes of this section, “use” means loading the Software into RAM, as well as
installation on a hard disk or other storage device.

The software and accompanying graphic, sound and video files contain copyrighted material,
trade secrets and other proprietary material and in order to protect them you may not
decompile, reverse engineer, disassemble or otherwise reduce the software to human-
perceivable form. You may not modify, rent, lease, loan, distribute or create derivative works
based upon the software.

• Export Law Assurances.  You agree and certify that neither ActionLine nor any other technical
data received from IMC will be exported outside the United States except as authorized and as
permitted by the laws and regulations of the United States.

This license shall be effective until termination. You may terminate this license by destroying
all copies of the software and documentation. IMC may terminate this license if you fail to
comply with any provision of this license agreement.

• Limited Warranty
The software and documentation are provided to you “AS IS” and without warranty of any
kind. IMC, its distributors and dealers, make no warranties or representations, either expressed
or implied, as to the software and its documentation, including the condition of the software
and the implied warranties of fitness for a particular purpose or merchantability. IMC shall
not be liable for any incidental or consequential damages arising from the use of this software,
and in no event, shall IMC’s liability exceed the purchase price of the software and
documentation.

This license agreement shall be governed by the laws of the State of California.
IMC warrants that the medium containing the software shall be free of defects for a period of
90 days after purchase.

Copyright 1996© Interactive Media Corporation, all rights reserved.
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1.  Introduction
Welcome to ActionLine, a unique and powerful tool for creating

interactive, dynamic Java™ applets for integration into HTML web pages.

With ActionLine you will be able to build web pages that provide for more

effective communications.  No programming or scripting knowledge is

required to create these applets, as ActionLine uses a unique, intuitive

graphical user interface, and supports Drag and Drop technology.  You can

create on screen buttons that will present a variety of graphic text and sound

files, all from within a single web page.  You can give the people who view

your pages the option of controlling the timing and appearance of each media

type, or you can design an applet that will function automatically according to

the timing you wish to employ.

Creating these applets is easy, and can be learned in several hours or less.

It is assumed that you have already had some experience building traditional

web pages using HTML tags with  a text editor or page creation tool like

WebWeaver or Adobe Page Mill™.  We also assume that you have

previously had experience placing your HTML pages on a server.  You will

also need a Java enabled browser that runs on your Macintosh.

ActionLine consists of three components.  The ActionLine Editor, the

ActionLine Viewer, and the JavaViewer.  The first two components are

Macintosh® based, and are available in either 68K or PowerPC versions.

They will remain on your Macintosh when you are creating applets.  The

JavaViewer will ultimately be placed on your server, along with any applets

you create, and the HTML pages that incorporate the applets.  These Java

components can be placed on any type of server, Unix, PC based, Macintosh or

others.  This allows your applets to be viewed by any computer user,

regardless of platform type, as long as the computer has a web browser which

supports Java.

This Getting Started manual will take you through the process of creating

several applets.  It will also provide a quick and easy introduction to using the

key features of ActionLine.  To learn more about what you can do with

ActionLine you will want to either experiment on your own, or read the

accompanying ActionLine Reference Manual.
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2.  Installation

You may have received your copy of ActionLine either electronically or

on disk.  If you received it electronically, it will already be on your computer.

If you received the disk version, insert the disk in your computer, double

click on the ActionLine™.sea icon and ActionLine will be installed on your

computer.  When you are done with the installation, you should have a

folder that looks like the one in Figure 1.

Figure 1.- ActionLine Folder Contents

To use ActionLine you will need a Macintosh based system with at least 5

Mb of RAM memory, and 10 Mb of hard disk space.  You will also need to be

running Macintosh system 7.1 or higher and have QuickTime™ version 2.5

or higher installed.

Serializing your product.  When you received your copy of ActionLine

you also received a Serial Number.  You will need this number to proceed

with the rest of this manual.  You also should keep a copy of your Serial

Number for future reference.  You will need it if you move your copy of

ActionLine to a new computer,  or if you request technical support from

Interactive Media Corporation
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3.  Creating your first Java™ applet
To get started, open your ActionLine folder and locate the icon called

ActionLine Editor (either the 68K or PPC version, depending on the version

you ordered).  The 68K version will run on any Macintosh compatible system

and the PPC version will only run on computers which contain a PowerPC

processor.

Open the ActionLine Editor either by double-clicking it, or choosing Open

from the File Menu.  You will get a dialog box asking you to put in your name

and serial number.  After doing this, you will have a screen similar to that in

Figure 2.

Figure 2. - Initial Slide

1.  Drawing Portals on your Slide

In ActionLine you will be creating an interactive Slide.  You will use

the Tool Bar , shown in Figure 3, to draw regions on the screen called Portals.

Portals can serve several different purposes.  A Portal can:

a).  Contain an image, an image sequence, a sound or text

b).  Be an interactive button, which triggers an action when it is pressed

c).  Be both a button and contain information.

d).  Be a destination for an action such as Play, Stop, Hide, Show etc.
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e).  Be an origin for an action.

In the course of this manual we will use portals for many of these

purposes.  Let's create our first series of Portals.

Figure 3.-Tool Palette

Go to the Arrange Menu and make sure the first line reads "Snap to

Grid".  If it says "Don't Snap to Grid", click on it and it will switch to "Snap to

Grid".  With this function selected, it will be easier to create portals of

uniform size and it will make positioning the portals easier.

Click on the Portal Tool  in the Tool Palette  and draw eight portals similar

to those shown in Figure 4.  Your portals will not have numbers-we have

added numbers for purposes of discussion and illustration only.  Your portals

do not have to be exactly identical to those shown in Figure 4, but try to

achieve  something similar in composition and arrangement.  If you need

help in arranging your Portals, you can go to the Display Menu and select

Show Grid, which will allow you to move and space your portals more

accurately.

To move a Portal you have already created, choose the Selection Tool,

click on the Portal, and drag it to the location you want it to be in.  You can

also move a selected Portal with the arrow keys.  To remove a Portal, select it,

and press the delete key on your keyboard.
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       After you have created

your Portals, Save  your slide.

Go to the File Menu and select

Save .  You will be asked to

enter a name for your slide.

Type in "MySlide1" and click

the Save  button.

➡  It is a good idea to Save

your work often.

Figure 4. - Slide with Portals

2.  Putting Text and Images in your Portals

Adding text to portals is easy.  Simply select the Text Tool from the Tool

Palette and click on Portal #1.  Type in "Welcome to My Show"  To set the

font properties, choose Get Data Info from the Content Menu.  A dialog box

will come up allowing you to choose a font, font size, style and color.  Choose

Helvetica 18 for the font, and choose Bold for the style, the press "OK".  Do

not choose a text color yet.

Add images to portals #2, 3, 4, 5 and 7. Choose the Selection Tool, click on

Portal #2 and select Place Data from the Content Menu.  This will bring up a

dialog box which will allow you to choose an image file.  Navigate to the

Images folder within you ActionLine folder.  Choose the image called

"-1btn.blusq20x20" and click the "Open" button.  This will place a small blue

button, with yellow borders inside your portal.  If your portal is too large,

resize it using the selection tool.  Place the same image in portals 3, 4 and 5.

You could also have used the Drag and Drop feature of the Macintosh to drag

the image file into your portal.  Select portal # 7 and place the image called

"NEXTredright" in it.

➡ Save your work again!
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3.  Creating Interactive Buttons with ActionLinks

You are now going to make your portals into dynamic, interactive

buttons, that will initiate  a variety of actions when the person viewing your

slide clicks on it.  Interactive effects are accomplished using the  ActionLink

Tool to connect two portals.  The portal which the link starts in becomes a

button.  The portal which the link ends in becomes the location in which the

action will take place.  This will become clearer as we create the first few links.

4  Creating Interactive Links with the ActionLink Tool

Select the ActionLink Tool

from the Tool Palette.  Draw a

link which starts in portal # 2

and ends in portal # 1.  With

the link still selected (as

evidenced by the two black

squares at either end of the

link), go to the Action Menu

and from the sub-menus

within it, choose Portal and

Set Color.  As shown in Figure

5.

Figure 5 - Set Portal Dialog

A dialog box will come up, with the Color Picker which will allow you to

choose a background color for the portal.  Pick a bright yellow.  This color will

appear in the background when the slide is run and button 2 is pressed.
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     Apply a Transition to the

color, by selecting the

Transition Menu which

appears as a sub-menu in the

Action Menu.  You will get a

dialog box illustrated in Figure

6.  Choose the transition called

"Left To Right Wipe".  Select a

transition speed of 8, and click

the "OK" button.

Figure 6. - Transition Dialog box

Now continue to build more links.  Use the ActionLink Tool to draw a

link from port #3 to portal #1.  From the Action Menu choose Data and Set

Text Color.  Another dialog box will come up allowing you to choose a color

for the text.  Select a dark blue color and click the "OK" button.  Also select a

Transition for the text color.

      Add a link from portal #4

to portal #6. From the Action

Menu select Data and then

choose the Place File sub-

menu. Now navigate to your

Images folder and choose the

picture titled “Jellybeans” and

click the” OK button”  Choose

a transition for this image.

Figure 7. - Slide with 3  Links

When you are done, your slide should look like Figure 7.

➡  Save  your Slide.
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5. Links as  Blueprints of Interaction

Each link conveys important information about the interaction you have

specified.  This is useful as you go back to make revisions to your slide.  Here

is a brief description of what the links tell you.  Look at the topmost link in

Figure 7.  It reads “1 WLR8 Set Color”  The number 1 specifies this as the first

link created in portal #2.  Portals can have multiple links coming out of

them, but in this example there is only one.  Subsequent links would have

the number 2, 3, etc.  The letters “WLR” specify a transition, namely

W ipeLeftRight.  Each transition has a unique abbreviation.  The number “8”

specifies the speed you chose for the transition, namely speed 8.  The final

part of the link, “Set Color” specifies the link action, namely Set Background

Color.  After you have worked with ActionLine for a little while, you will

recognize all the links.  You can select a link at any time, and change it’s

properties.  You can also delete a link by selecting it with the Selection Tool

and pressing the delete key on your keyboard.  Links and portals may be

copied and pasted within or between slides.

If your slide gets too busy with links and graphics, you can hide one or

both items by going to the Display Menu and Hiding or Showing the Links or

Data.

6. Completing and Viewing your first slide

To complete your slide, add a link from portal # 5 to portal #8 and choose

“Place Text” from the Data sub-menu of the Action Menu.  This will bring up

a dialog box, into which you can type “Interaction Now!”  After entering this

text, click the Text Attrs... button to assign a font, size and color to the text.

Choose Helvetica, 12 point, bold, and a dark color of your choosing.  You may

also apply a transition to the text after you click the “OK” button in the Text

dialog box.

Draw an ActionLink from portal #7 to any empty region of your slide.  In

the Action Menu choose “Navigate” and select Go to URL...  A dialog box will
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come up.  Type in “MySlide2.html”.  This navigation button will take you to

a new web page, containing your second Java applet, which we will create

later.

➡  Save  your Slide.

To Preview what you have created, select Preview Slide from the File

Menu.  This will launch the ActionLine Viewer.  The preview will give you a

representation of what your slide will look like in a browser, but it is not an

absolute representation of what you will see.  Each browser will display your

slide somewhat differently.  In the Tips and Tricks section of this manual we

will give you some ideas on how to make your slides look best in a browser.

Also, the ActionLine Viewer cannot show the navigation functions, since

these only occur when you are looking at your slides in a browser.  While the

ActionLine Viewer is a very useful tool for getting a quick look at what you

have created, it is important to view your finished slides in a browser to get a

complete sense of how they will appear.  You should also be aware that

different browsers implement Java somewhat differently, so you may get a

different look on one browser than you will on another.

7. Adding Background Colors to Slides and Portals

As you viewed your slide, you noticed that the background of the slide is

white as are all the portals that do not contain images.  It is possible to set the

colors of the slide background and the portal backgrounds.  To set the Slide

Background  select Set Slide Info from the Content Menu.  A dialog box will

come up with a color picker.  Do not change the slide size, but select a dark

blue color for the slide background.  Then click the “OK” button.

To set a Portal Color  select portal #6 with the selection tool, and either

double click on the portal, or choose Get Portal/Line Info  from the Content

Menu.  You will get the dialog box illustrated in Figure 8.
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Figure 8 - Portal Attributes Dialog Box

To place a frame around the portal, set the Frame Width to 4 (pixels) and

choose a red color from the color selector in the Frame section of the dialog

box.  When you have a frame color you like, press the “OK” button.  Now

choose a portal color from the Color Selection box in the lower left region of

the Portal Attributes Dialog.  Choose a dark blue color, click the “OK” button

and close the dialog box by clicking in the close box in the top left corner of the

dialog box.  This will set both the frame and background colors.

➡  Save  your Slide.
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4.  Preparing slides for your server
Now that you have created your first slide, you are ready to prepare it for

viewing in your browser and for placement on your server.  ActionLine helps

make this process easy.

1. Building your folder for placement on your server

Make sure your  slide called MySlide1 is open in your ActionLine Editor.

From the File Menu choose Build Java Release.  A new folder will be created

on your computer, called MySlide1 Java.  The folder will contain three items;

1.  a copy of your ActionLine Document titled MySlide1,   2.  A folder called

Images, and 3.  a web html document called MySlide1.html.

2. Converting images for use on the web

Inside your MySlide1 Java folder is a folder called Images.  This folder

contains copies of all images used to build your slide.  This folder will be

placed on your server, but first you must convert the images to the graphics

formats supported by the web, namely Gif or JPEG.  The original images you

used to create your slide were either Gif, JPEG, PICT or Photo CD™ images.

The PICT images  in this Java folder must be converted to either JPEG or Gif.

The conversion can be done by many image conversion programs, including

Adobe PhotoShop, DeBabelizer™ or freeware or shareware such as clip2gif  or

GIFConverter.  We provide links to many of this utilities from our web site at

<http://www.imcinfo.com>.

For purposes of this tutorial, we have already done the conversions for

you.  You will find the proper files in a folder called "Converted

Images"inside your ActionLine™ Folder.  Simply open this folder, and drag

the images into the Images Folder in your MySlide1 Java folder.

3. Adding the JavaViewer

Open the folder called JavaViewer which is inside your ActionLine

Folder.  Copy the contents of this folder (not the folder itself) into your
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MySlide1 Java folder.  Your MySlide1 Java Folder should look like Figure 9.

The icons on documents may be different on your computer. You can open

the html  document in any text editor or web authoring tool.

Figure 9. - Completed folder

4. Viewing your applet in your browser

You can view your slide in your browser by dragging the file

MySlide1.html to your browser.  If you wish to make changes in your applet,

simply open it in your ActionLine Editor, make the changes and save a copy

to your MySlide1Java folder.

5. Adding the applet and associated files to your server

You can now add the applet to your server.  You must copy the entire

contents of the MySlide1 Java Folder to the  folder on your server that

contains your html index page.

➡   If these files and folders are posted to a different level on your server, they

will not run properly.

➡   Remember, copy the contents of the folder, not the folder itself.
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If you wish to have your applet run within an existing web page, simply

open the MySlide1 Java.html document,  copy the  following text, and place it

in your own html page, somewhere between the <BODY> and </BODY> tags.

<applet code=CActionLineApp.class width=200 height=160>
<param name=DocumentFile value=MySlide1>

<param name=ImageFolder value="Images">
<param name=ImageSequenceFolder value="ImageSequences">
<param name=SoundFolder value="Sounds">

</applet>

6. File naming conventions-avoiding problems on the web

It is important to remember that the names of files used when creating

the applet in the ActionLine Editor, and the files that appear on the server,

must match exactly.  Otherwise the JavaViewer will not be able to locate the

proper file, and you will generate an error.

File naming conventions for the JavaViewer are also more restrictive

than on the Macintosh.  It is best to avoid any spaces in file names, and special

characters, such as the # and / symbol..  It is best to use only the alphanumeric

keys to name files.  If your applet cannot locate a file, check carefully that the

names match exactly between the Editor and the JavaViewer, and that no

unusual characters are used.
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5.  Adding more features to your slides
In this section we are going to create a new slide that uses more of the

features of ActionLine, including image sequences, animation, sequence

attributes and rollover buttons.  Image sequences are a series of two or more

images that ActionLine will display in order.  Each image sequence that you

use is kept in its own folder, inside the ImageSequences Folder.  Image

sequences are used for both animations and for rollover and highlight

buttons.  In the case of buttons, there are only two images per sequence.  For

animations, you can have two or more images.

Create a new slide, with a series of portals identical to your first slide.  You

can do this either by creating an entirely new slide from scratch, or by

selecting your first slide and choosing  Duplicate from the File Menu.  If you

duplicated the first slide, name the new one MySlide2.  If you duplicated the

original slide, use the selection tool to select and delete all the ActionLinks.

We will be using the same buttons in portals 2, 3, 4 and 5 that we used in the

first slide.

1.  Using Image Sequences and Rollover buttons

If you created this slide by duplicating it, the images will already be

selected.  If you created it from scratch, place the images in the same manner

you used as in Chapter 3.  Select Portal 1 with the Text Tool and type My

Show-Continued!  Select portal #7 and choose Place Image Sequence from the

Content Menu.  When the file selection dialog box appears, select the

ImageSequences folder inside your ActionLine™ folder.  Click on the folder

named Nextbuttons and press the "Select Nextbuttons" buttons as shown in

Figure 10.  This will place the image sequence in portal #7.  Now double-click

on portal 7, and the portal attributes dialog will come up.  It will look like

Figure 8.  Check the "Rollover" checkbox.  This will specify that when a

mouse is on top of portal #7, the image will switch from the first image in the

Nextbuttons sequence to the second image.
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Figure 10. - Choosing an Image Sequence

Now choose portal #6, and choose the Place Image Sequence from the

Content Menu.  This time select the image sequence called BoltrotationA.

Using the Selection Tool, resize the portal to the size of the lightning bolt

image.  Save your new slide.

2. Animation

Draw an ActionLink from portal #2 to portal #6.  Choose Start Animation

from the Action Menu.  A dialog box will come up as shown in Figure 11.  Set

the speed to 7 and click the "OK" button.  This will make button 2 start the

image sequence when it is clicked.

Now draw a link from portal #3 to portal #6.  Again choose Start

Animation.  This time we are going to create an animation path.  Start by

moving your mouse to the red dot in the top left corner of the rectangle

representing portal #6.  Hold down the mouse and draw a path similar to that

shown in Figure 12.  Set the Speed to 8 and the Cycles to 5.  Speed determines

how fast the image sequence will play, and the Cycles setting determines how

many time the entire image sequence will play as it traverses the path.  Nodes

can also be selected and moved, if you want to change the path.  The portal
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will traverse the path at a uniform rate from node to node.  If you select

individual nodes and remove them, the portal will speed up over the area of

the missing node.  This will allow you to have your animation accelerate and

decelerate as it traverses the path.

➡  Save  your Slide.

Figure 11. - Animation Dialog
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Figure 12- Animation path

3.  Sequence buttons

Draw a link from portal # 4 to portal #6.  From the Action Menu choose

Place File and select the file in the Images folder called "USFlag-button".

Apply a transition of your choice and set the speed to 7.  Draw another link

from portal #4 to portal #6.  Place another image, called "Lighthouse.  Give it

a transition and a speed of 7.  Double click on portal #4 until you get the

Portal Attributes dialog box.  In the Behaviors section select the attribute

called "Sequence".  This tells the viewer that when portal #4 is pressed the

first time, it should put the USFlag image in portal #6.  If portal #4 is pressed

again, it will place the Lighthouse image.  Using sequence buttons you can
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display an entire slide show, or a combination of images and text, depending

on the type of links you create.

Draw a link from portal # 5 to portal #8 and choose the Place Text from

the Action Menu.  Type the message, "That's all folks!".  Choose a font size of

12 and a bright color, using the Text Attributes dialog.

➡  Save  your Slide.

As the last item for this slide, Draw an ActionLink from portal #7 to any

empty region of your slide.  In the Action Menu choose “Navigate” and select

Go to URL...  A dialog box will come up.  Type in “MySlide1.html”.

➡  Save  your Slide.

Preview your slide using the Preview Slide command in the File Menu.

If you want to make changes to your slide, go back into the editor and make

them.  Otherwise, Build your Java Release as you did in Chapter 4.  We have

provided the converted images and imagesequences you need for this slide as

well.  Simply drag them from the "Converted Images Folder" to the matching

folders in your MySlide2 Java Folder.

It would be a good idea to combine your Java folders in the following way.

Since the Java Folder for MySlide1 already contains the JavaViewer

components, and an Images Folder,  Simply drag all converted images into

the Images Folder.  Also move the ImageSequences Folder from the

Converted Images folder to your MySlide1 Java Folder.  Also move the

MySlide2.html document into the MySlide1 Java Folder.  When you are

done, your folder should look something like Figure 12.  You should now be

able to test your 2 html pages by dragging them to your browser.
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Figure 12 - Combined folder for browser testing

4.  Summary

If you have worked your way through this manual, you should have a

good understanding of the basic operation of ActionLine.  You can go on to

explore other features and functions of the product by simply experimenting

on your own, or you can consult the Reference Manual for a full listing of all

of the features of the product.

Please visit our web site often, as we continually provide new tips, tricks

and examples of ActionLine at work.
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6.  Tips and Tricks
This chapter will provide some useful ideas for working more effectively

with ActionLine.  As with many software tools, there are often multiple ways

to achieve a particular result.  This is certainly true for ActionLine.  While we

have illustrated some useful methods to accomplish things, you should bear

in mind that there you may find a better way to achieve the results you want.

Don't be shy about trying out and experimenting with the wide array of

ActionLine functions and commands.

1.  File Formats

As we have described in the preceding sections the ActionLine Editor and

Viewer use different file formats for graphics and sound than the JavaViewer.

Table 1. details the specific file formats supported.  It is important to make

sure that all files are converted to appropriate format when you want to run

your applets.  Both commercial, shareware and freeware tools are available

for doing all of these file conversions.  Many of them are listed on our web

site.

Summary of File Formats supported by ActionLine Version 1.1
File Type ActionLine Editor & Viewer JavaViewer

Images Gif, JPEG, PICT and Photo CD Gif and JPEG

Sound AIFF au

Table 1.  File Format Requirements Version 1.1

2.  Text Handling within Java and the ActionLine Editor

As you know, your Macintosh supports a wide variety of fonts.  However,

in preparing Java applets for the web, you are limited to only five font types

supported at present by Java.  These fonts are: Helvetica, Times Roman,

Courier, Symbol and Dialog.  If you use a different font when you generate

text in the ActionLine Editor, Java will substitute a font.  Each browser
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implements fonts somewhat differently, so you always need to view your

final slides in a browser to make sure you are getting the result you intended.

In addition, because each browser handles fonts slightly differently, it is a

good idea to allow some extra space in your portals for font resizing.

Otherwise some of your text may be clipped when it is viewed in a browser.

Word wrapping in Java.  When creating text in your ActionLine Editor.

you must insert carriage returns whenever you want a new line to start.  The

work wrapping you see in your portals will only be implemented in the

JavaViewer if there is a hard line break.  Otherwise you may have unexpected

results with your text.

3.  File names

It is important to remember that Java and your web browser are more

restrictive than your Macintosh in handling file names.  Avoid spaces and

special characters in file names.  It is best to use only alphanumeric characters

in  file names that will be used in creating you applets.  This applies not only

to the name of your applet, but to all files including images, sounds and

image sequences.

4.  Efficient creation of portals.

If you are going to be needing multiple portals with the same image and

same attributes, such as buttons, it is easier to create one portal, enter the

graphic and set the portal attributes, and then Copy and Paste this portal to

replicate it.  You can also Copy and Paste portals and ActionLinks within a

slide and between slides.

When placing images in portals, and when using ActionLinks  to place an

image, you can use the Macintosh Drag and Drop capability to drag the

appropriate image or sound.  You can also drag text into a portal, although

you cannot drag text to a link.
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